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Abstract

We focus on controlling morphological and histochemical responses of the
shoot apical meristem (SAM) and root apical meristem (RAM) of bamboo
node by using a simple and versatile liquid culture system. First, nodes of 11
different bamboo species that belong to seven major bamboo genera (Bam-
busa, Dendrocalamus, Phyllostachys, Tetragonocalamus, Chimonobambusa,
Pleioblastus, and Sasa) were cultured using 2 mL per well of a liquid medium
in a 6-well microplate to form a small-scale liquid culture environment
(SLCE). The dormant lateral buds of all bamboo nodes resumed expanding
and elongating within 7 days in the SLCE. The dormant and active lateral
buds were sectioned longitudinally and stained with Sytox green (SG) to
monitor mitotic activity and counterstained with safranin (SF) to detect the
inward region of the SAM region. Further, mitotic activity was calculated us-
ing a digital imaging analysis, which showed an increase of up to 1.2- to
3.8-fold in terms of the SG/SF ratio after 7 days in the culture. Moreover, we
used in vitro node cultures of two typical bamboo species, the sympodial
clump-forming type (Bambusa multiplex Raeush, Bm) and the monopodial
single culm-forming type (Phyllostachys meyeri McClure, Pm), and noted the
following: 1) since gradual white-to-green tinge shoots were observed, we in-
vestigated the relation between color variation in the outer regions of culm
and node tissues and their suitability as explants. By checking the autofluo-
rescence property of whole shoots under LED 365 nm illumination with an
RGB (red, green, and blue) digital imaging analysis using Image]J software, we
specified the color variation of explants as the relative intensity of the blue
value. 2) Since the obtained shoots of a 1-month-old culture box showed
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growth variation, we distinguished shoot types based on plant height, ie,
short (less than 5 cm), medium (ca. 5 - 10 cm), and tall (more than 10 cm).
Tall shoots that have ca. 5 nodes on average were suitable for explant. 3)
Three types of node portions—the first node (the base node near a rhizome
tissue), middle nodes (upper nodes near the 1% node), and the top meris-
tem—were independently cultured in the SLCE, and it was found that the
first node showed the best growth performance. 4) By culturing the first node
in the SLCE system, we performed a quick survey during the 3 weeks in the
culture and found that a combination of 10 uM benzyl adenine and 3 pM
thidiazuron was effective for in vitro SAM development, while the addition of
2, 4-D was effective for promoting in vitro RAM development. 5) The de-
tailed autofluorescence properties of the outer regions of culm and node tis-
sues were also identified using an inverted fluorescent microscope under B-
and U-excitation lights with RGB and HSB (hue, saturation, and brightness)
digital imaging analysis.
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1. Introduction

Bamboo plants that belong to the Poaceae family, which contains more than
1500 species, have been exploited for a range of uses, such as food, medicine,
charcoal products, and housing materials, especially in Asia [1] [2]. It is well
known that bamboo presents unique biological properties in its vegetative
growth. A rhizome system is a key to maintain the lateral growth and form new
culms with abundant nodes for longitudinal growth without secondary growth.
The system is mainly classified into two types of growth feature: one is the sym-
podial and the clump-forming type (e.g., Bambusa sp.), which is distributed in
tropical regions, and the other is the monopodial and single culm-forming type
(e.g., Phyllostachys sp.), which grows mainly in temperate and subtropical re-
gions [3].

A tissue culture protocol of bamboo (Phyllostachys meyeri McClure, Pm) was
successfully achieved by Ogita et al (2008) specifically regarding 7n vitro germi-
nation of the caryopses and plant regeneration from nodal segments of both the
germinated seedlings and tissue-cultured clone plants [4]. In vitro node culture
stocks of (Bambusa multiplex Raeush, Bm) have also been established using the
method for Pm, as previously reported. Hence, several clonal small plantlets of
two major bamboo species that have a high ability to form multiple shoots were
obtained in a regular period (ca. every 1 - 2 months), as shown in Figure 1. The
node portions of these culture stocks with apical and intercalary meristems were
considered as excellent models for the morphological and histochemical re-

sponse control of the shoot apical meristem (SAM) and root apical meristem
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Figure 1. The features of in vitro node culture

stocks of (A): Bambusa multiplex Raeush, Bm;
and (B): Phyllostachys meyeri McClure, Pm.

(RAM) of bamboo. General tissue culture techniques for in vitro micropropaga-
tion of bamboos through enhanced axillary branching using node explants have
been well reviewed, e.g. by Singh et al (2013) [5]. Factors affecting success in
micropropagation of bamboos such as medium, plant growth regulators, me-
dium pH, carbon source, propagule size, and culture duration were summarized
in this report. However, there is no detailed description of a versatile methodol-
ogy to regulate /n vitro growth of bamboo nodes. The aim of this study is to re-
view a simple but versatile node culture system in a liquid culture environment
to better understand unique biological properties of its vegetative growth and to,
thus, reveal the relation between color variation in the outward regions of culm
and node tissues and their suitability as explants.

The concept of the Plan-Do-Check-Act (PDCA) cycle in a plant tissue culture
[6] is central for the present study. Generally, researchers should realistically
consider the following requirements: explant selection, medium preparation,
and culture environment setting in the P and D cycles. Based on a careful moni-
toring of size, shape, and color variation of the target cells and tissues by macro-
and micro-scopic observations, they can recognize the specific pattern of growth
promotion and/or inhibition during the culture of the target explant. These in-
puts are considered highly useful and interesting for the optimization of a pro-
tocol, especially regarding the C and A cycles.

A main topic of the present study is the culture environment setting. Sood et
al (2002) tested the effects of agar-solidified medium and liquid medium on
shoot multiplication, whereby root formation of Dendrocalamus hamiltonii was
investigated; it was found that a liquid culture condition is more suitable for the
tissue culture of this bamboo species [7]. Using node culture system, we checked
the effects of solid and liquid media on the growth of bamboo node cultures of
Bm and Pm, and found that better growth performance was observed in the lig-
uid medium condition (Table 1). Based on this preliminary result, a 6-well mi-
croplate that contains 2 mL per well of a liquid medium, which provides a
small-scale liquid culture environment (SLCE) for optimizing the culture proto-

col of the bamboo within a short period was focused in the present study.
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Table 1. Effect of solid and liquid medium conditions on growth performance of bamboo
node cultures.

Growth performance

Species/

medium Plant height No of No. of roots/ Length of . Weight
condition (cm) shoots/ explant root incensement

explant (cm) (mg)

Bm/Solid 4.22 +£0.95 1.2+£0.12 1.4+0.47 584 +1.11 96 + 0.03
Bm/Liquid 9.9+1.16 1.2+£0.15 4.6 £0.59 8.26 £ 1.39 338 £ 0.04

p-value 0.00139** 0.5 0.011866** 0.165642 0.003522**
Pm/Solid 495+ 1.17 1+0.21 2.1+0.45 2.1+1.19 44 + 0.42
Pm/Liquid 7.6 £ 3.00 1.6 £0.40 2.4+0.75 8+1.27 191 £ 0.38

p-value 0.216171 0.086002 0.85559 0.044966** 0.011815**

Growth performance was summarized after 30 days in culture. Data represent the average values + SD from
5 explants. Data for each column were analyzed by a Student’s t-test. **Significant at 0.05.

Another main topic of the present study is the autofluorescence measurement
technique. Autofluorescence (primary fluorescence) is the fluorescence of natu-
rally occurring substances, such as chlorophyll, collagen, and fluorite. Most plant
and animal tissues show some autofluorescence when excited with ultraviolet
light (e.g., light with a wavelength of approximately 365 nm) [8]. In the previous
studies, we focused on evaluating the autofluorescence intensity of target plant
cells, which reflects the histochemical features of the plant cell wall [9], and ac-
cumulation of specific secondary metabolites [10]. We also used digital imaging
analysis to measure the growth features in a protoplast co-culture assay [11].
Currently, in the field of life sciences, the concept and application of autofluo-
rescence measurement have developed with the requirement of non-destructive
detection of a target cell and tissue [12] [13] [14]. In the present study, the color
variation of explants as the relative fluorescent intensity by assessing the autof-
luorescence property of the whole shoots under LED 365 nm illumination with
RGB (red, green, and blue) digital imaging analysis using Image] software was
focused. The detailed autofluorescence properties of the outward regions of
culm and node tissues were also identified using an inverted fluorescent micro-
scope under B- and U-excitation lights with RGB and HSB (hue, saturation, and
brightness) digital imaging analysis.

2. Materials and Methods
2.1. Plant Materials

Nodes of 11 different bamboo species that belong to seven major bamboo genera
were cultivated using planter boxes in a greenhouse of Toyama Prefectural Uni-
versity, Japan: Bambusa—B. multiplex Raeush (Bm), B. glaucescens f. Horaiko-
machi (Bg), B. oldhamii Munro (Bo); Dendrocalamus—D. giganteus Munro
(Dg); Phyllostachys—P. bambusoides Sied. Et Zucc (Pb), P. nigra Munro var.
Henonis (Pn), P. pubescens Mazel ex ]. Houz (Pp); Tetragonocalamus—T.
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angulatus (Munro) Nakai (Ta); Chimonobambusa—C. marmorea (Mitford)
Makino (Cm); Pleioblastus—P. simonii (Carriere) Nakai (Ps); and Sasa—S.
kurilensis Makino et Shibata (Sk). Fresh nodes were collected from the branches
of these bamboo plants and cultured in vitro according to a method previously
reported [4]. In vitro node culture stocks of Bm and Pm maintaining at
Prefectural University of Hiroshima, Japan were also used in the following expe-
riments to understand the sequential developmental processes of SAM and RAM
of node explants. Briefly, a half-strength MS (Murashige and Skoog) [15] liquid
medium that contains 30 g/L sucrose was prepared as a standard medium, unless
otherwise specified. The pH of the medium was adjusted to 5.7 before autoclav-
ing. All the cultures were maintained at 25°C, with a 16 h photoperiod under

fluorescent illumination (65 umol m™s™").

2.2. Node Culture Protocol and Its Applications

A versatile node culture protocol using 2 mL per well of a liquid half-strength
MS medium with a 6-well microplate (#353046, Corning), which provided a
small-scale liquid culture environment (SLCE) was demonstrated. One node
segment (1.5 - 2.0 cm in length) of each bamboo plant was placed in a well of the
SLCE. Mature dormant nodes from greenhouse grown bamboo branches and
the first node (the base node near a rhizome tissue) from the in vitro node cul-
tures of Pm and Bm were used in the experiments, unless otherwise specified.

Three types of node portions—the first node, middle nodes (upper nodes next
to the 1st node), and the top meristem—were independently cultured in the
SLCE to define a bent for the explants. Effects of plant growth regulators, such as
benzyl adenine (BA, Wako Pure Chemical Corp.) and thidiazuron (TDZ, Wako
Pure Chemical Corp.), on induction of in vitro SAM development, and effects of
2,4-dichlorophenoxy acetic acid (2,4-D, Wako Pure Chemical Corp.) on the
promotion of in vitro RAM development were also investigated after a short pe-
riod in the SLCE.

2.3. Observations and Digital Imaging Analysis

Dormant and active lateral buds of 11 bamboo species were sectioned longitu-
dinally and stained with Sytox green (SG, Thermo Fisher Scientific) to monitor
mitotic activity and counterstained with Safranin O (SF, Wako Pure Chemical
Corp.) to detect the inward region of the SAM region based on a previous me-
thod [16] with a minor modification.

In order to evaluate growth performance of explants, whole images of in vitro
cultured shoots were captured with a digital camera system (UV CUBE, LC
science Co., Ltd.) under a bright-field and LED 365 nm illumination without
staining. The autofluorescence property of the obtained images was evaluated by
RGB (red, green, and blue) digital imaging analysis using Image] software. A
stereo microscope (SZ40, Olympus) was also used to monitor the morphological

characteristics of the target tissue. The detailed autofluorescence properties of
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the outward regions of culm and node tissues were observed using an inverted
cell culture microscope (CKX53, Olympus) under B- and U-excitation lights [B;
Band pass (BP) filter, 460 - 495; Barrier (BA) filter, 510IF; Dichroic mirror
(DM), 505, U-FUW; BP filter, 340 - 390; BA filter, 420IF; DM, 410] with RGB
and HSB (hue, saturation, and brightness) digital imaging analysis. The HSB
color space in Image] software is regarded as equivalent to the HSV (hue, satura-

tion, and value) color space.

3. Results

3.1. Histochemical Analysis of Mitotic Activity in Node Portions of
11 Bamboo Species

As shown in Figure 2, the dormant lateral buds of all bamboo nodes resumed
expansion and elongation within the first 7 days in the SLCE. The mitotic activi-
ty was calculated by a digital imaging analysis and found an increase of up to
1.2- to 3.8-fold in terms of the SG/SF ratio after 7 days in the culture (Table 2).

(B)

Figure 2. Histochemical analysis of mitotic activity in node
portions of 11 bamboo species. A; dormant stage (0 day), B;
active stage (7 days). Longitudinal sections of the lateral buds
were stained with Sytox green (SG, yellow) and counter
stained with Safranin (SF, red). Relative activity was calcu-
lated as the ratio of stained area (SG/SF) in Table 2.
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Table 2. The mitotic activity in the node portion of 11 bamboo species.

Relative activity (SG/Saf)*

Bamboo species

Dormant stage Active stage Fold
Bg 0.069 0.084 1.22
Bm 0.058 0.083 1.45
Bo 0.079 0.133 1.68
Dg 0.040 0.062 1.57
Pb 0.037 0.069 1.86
Pn 0.036 0.059 1.63
Pp 0.050 0.109 2.17
Ta 0.007 0.025 3.82
Cm 0.040 0.064 1.59
Ps 0.068 0.098 1.44
Sk 0.032 0.056 1.75

*Relative activity was calculated as the ratio of stained area (SG/Saf) from Figure 2 by a digital imaging
analysis.

3.2. Morphological Features of in Vitro Bamboo Shoots

Systematically maintained in vitro node culture stocks of Bm and Pm, as shown
in Figure 1, were used in this experiment. Since gradual white-to-green tinge
shoots were observed, we investigated the relation between color variation in the
outward regions of culm and node tissues and their suitability as explants
(Figure 3). Color variation from pearl to light green under a white light could be
observed, which is especially dependent on the position of the internode in the
young shoot of Pn. On the other hand, there were no distinctive visible characte-
ristics of the outward regions of the in vitro shoot of Pm and Bm under a white
light. By checking the autofluorescence property of whole shoots under LED 365
nm illumination with RGB digital imaging analysis using Image] software, the
color variation of explants as the relative intensity of the blue value was speci-
fied. To refer to a color scale, positional differences of the relative autofluores-

cence intensity were also identified.

3.3. Growth Performance of in Vitro Bamboo Shoots

As shown in Figure 4, we could distinguish types of shoots according to the
plant height, i.e, short (less than 5 cm), medium (ca. 5 - 10 cm), and tall (more
than 10 cm)—specifically from a culture box of in vitro node culture stock. The
number of nodes per shoot varied depending on the size of the shoots. Tall
shoots that have ca. 5 nodes on average are suitable as explants.

Three types of node portions—the first node, middle nodes, and the top me-
ristem—were collected from tall shoots that were more than ca. 10 cm in height
and independently cultured in the SLCE to define a bent for the explants. The
first node showed better growth performance in terms of weight increment
(Figure 5). Further growth features of each node were also monitored (data not
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Figure 3. Autofluorescence of whole shoots under LED 365 nm illumination with an
RGB (red, green, and blue) digital imaging analysis. Young shoot of Pn (A)-(C), in vitro
shoot of Pm (D)-(F), in vitro shoot of Bm (G)-(I). Images in (A), (D), and (G) were cap-
tured under a white light. (B), (E), and (H) are autofluorescence images. (C), (F), and (I)
are examples of digital imaging analyses in blue mode indicating histochemical differenc-

es in the outward regions of the tissues.

Plant height (cm)
s

8
6
4
L[]
0

Short Medium Tall
Type of shoots
(A)
7
6
g 5
=
K4
8 4
°
2
w 3
=]
2 2
1
0
Short Medium Tall
Type of shoots

(B)

Figure 4. Categorization of the in vitro Pm shoot types according to (A) plant height, and
(B) number of nodes per shoot. Values were summarized after being cultured for 30 days.
Data represent the average values + SD from 5 independent stock cultures.
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Figure 5. Growth performance of first node (FN),
medium node (MN), and top meristem (TM). Data
represent the average values + SD from 3 explants.

shown) and it was concluded that the first nodes have superior bent for explants
of the bamboo node culture. By selecting the first nodes as suitable explants, a
quick survey to set a highly efficient culture condition became theoretically
possible.

Without selecting the best node tissues, e, first nodes, the resulting res-
ponses of a culture tend to vary widely. We effectively reconfirmed the superior
bent of the first node when a test survey that set a highly efficient culture condi-
tion was performed as follows. Different concentrations and a combination of
cytokinins, ie, 3 uM of TDZ, and 3 and 10 pM of BA, were used for in vitro
SAM development, and different concentrations of auxin, Ze, 0.1, 3, and 10 uM
of 2,4-D, were also evaluated for whether in vitro RAM development was pro-
moted. As expected, clear growth promotion and/or inhibition could be seen in
the SLCE, especially in terms of the day to bud break values (Table 3).

3.4. Autofluorescence Properties of the Outward Regions of Culm
and Node Tissues

Given the relation between color variation in the outward regions of culms and
nodes and their suitability as explants (see Figure 3), we attempted to identify
the detailed autofluorescence properties of the target tissues using an inverted
fluorescent microscope under B- and U-excitation lights with an RGB and HSB
digital imaging analysis. As shown in Figure 6, the mature node region, espe-
cially near the first node, showed various strong fluorescence intensities. When
B-excitation light was adapted, the images from the R and G modes of the RGB
analysis and the hue and brightness modes of the HSB analysis were estimable.
When U-excitation light was used, the images from the G and B modes of the
RGB analysis and the brightness mode of the HSB analysis were visible.
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Table 3. Effect of plant growth regulators on shoot/root/callus development from first

node explants.

Growth performance

Plant growth
Days to bud Length of
regulator (uM) t 5 Shoot/root/callus development
breaking (d) shoot (cm) p
0 15.8 £2.34 4.1+0.31 Single shoot elongation (control)

Single shoot elongation with moderate

TDZ3 8.00 + 0.84 2.9+0.32 AN
inhibition
Single shoot elongation with active

BA3 5.5+ 0.55 6.7 £0.22 .

promotion

BA 10 43 +0.55 71+ 433 Single s%loot elongation with active
promotion
Multiple shoots elongation with

BA 10+ TDZ3 3.00 £ 0.45 2.8+0.26 e
moderate inhibition
Single shoot elongation same as control
2,4-D 0.1 7.8 +0.82 44+0.16 Sl )

with single root elongation
Single shoot elongation and slight

2,4-D3 11.17 £ 0.89 3.8+0.08 . k
callusing at the base of the node tissue
Moderate callusing at joint region of

2,4-D 10 1.8 +3.03 0.15+0.25

node tissue

Growth performances were summarized after cultured for 21 days. Data represent the average value + SD

from 5 explants.

"5t node "

**+ 4th node "

RGB imaging analysis

(1) File>Open (Select a RGB color picture such as “.jpg”),

(2) Image>Type>RGB stack (Sprit the image into 8-bit grays),

(3) Image>Lookup tables>Spectrum (Red in B, Green in C, Blue in D).

HSB imaging analysis

(1) File>Open (Select a RGB color picture such as “.jpg”),

(2) Image>Type>HSB stack (Sprit the image into 8-bit grays),

(3) Image>Lookup tables>Spectrum (Hue in E, Saturation in F,
Brightnessin G).

Figure 6. Autofluorescence of the outward regions of the tissues of culms and nodes un-
der B- and U-excitation lights with an RGB and HSB (hue, saturation, and brightness)
digital imaging analysis.
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4. Discussion

A liquid medium condition has previously been suggested to be suitable for in
vitro bamboo tissue cultures, especially in three major bamboo genera (Bambu-
sa, Dendrocalamus, Phyllostachys) [4] [7] [17] [18]. In the present study, we in-
vestigated the effects of solid and liquid media on the growth of bamboo node
cultures of Bm and Pm, and found that better growth performance could be ob-
served in the liquid medium condition (see Table 1). Then, we focused on using
a 6-well microplate that contains 2 mL per well of a liquid medium, which pro-
vides a small-scale liquid culture environment (SLCE). The underlying concepts
of the SLCE are as follows: 1) to establish a simple and versatile liquid assay sys-
tem to control morphological and histochemical responses of SAM and RAM of
the bamboo node within a short period, and 2) to reveal the relation between
color variation in the outward regions of culm and node tissues and their suita-
bility as explants using techniques for autofluorescence measurement with a dig-
ital imaging analysis. For the first concept, we evaluated growth performance of
nodes from 11 different bamboo species that belong to seven major bamboo ge-
nera (Bambusa, Dendrocalamus, Phyllostachys, Tetragonocalamus, Chimono-
bambusa, Pleioblastus, and Sasa), and concluded that the first node is the best
explant for the bamboo culture system. As a test assay, we investigated the ef-
fects of plant growth regulators—both auxin and cytokinin—since it is well
known that these chemicals interact in a complex manner to control many as-
pects of growth and differentiation [19]. The auxin-cytokinin interaction in the
regulation of plant meristem development is overviewed in terms of biosynthe-
sis, transport, and signaling control [20]. As shown in Table 3, we recognized
that the combination of 10 uM of BA and 3 uM of TDZ was effective for in vitro
SAM development during 3 weeks of culture. The addition of TDZ served as a
trigger to induce multiple shoots. There are reports that TDZ is effective for en-
hancing micropropagation in cereal and grass plants [21] [22]. Moreover, the
addition of 2,4-D effectively promoted in vitro RAM development. Interestingly,
it was capable to monitor different bud breaking patterns (2 - 10 days after cul-
ture) with various RAM developments through the test assay. The low concen-
tration of 0.1 uM was effective for shoot and root development, while the high
concentration of 10 uM induced early bud breaking with callusing.

For the second concept, using macro- and microscopic fluorescence observa-
tion techniques, as described in the text, we estimated autofluorescence proper-
ties in the outward regions of bamboo node tissues by performing an RGB and
HSB digital imaging analysis. The color of an object can be described by several
color coordinate systems, referred to as color spaces. One of the most important
decisions for imaging analysis is to select a color space, of which the most popu-
lar is RGB, often used in video monitors. HSV (HSB in Image]) is an alternative
representation of the RGB color model designed to be more closely aligned to
human vision and perception of color-making attributes [23]. As shown in Fig-

ure 6, we compared all the images obtained, and decided a suitable combination
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of B- and U-excitation lights with an RGB and HSB digital imaging analysis.

5. Conclusion

To the best knowledge, this is the first report that suggests a versatile node cul-
ture method in the SLCE to control morphological and histochemical responses
of SAM and RAM in in vitro bamboo plants. Clear growth promotion and/or
inhibition could be seen in the SLCE within a short period. For future studies,
we are constructing detailed quantitative imaging analyses on the variation of
the autofluorescence property by adapting a method [24] with our new culture

system.
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